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Gereedschappen

Ankerpunt toevoegen-gereedschap =
Kleur toepassen ,
Standaard vul- en lijnkleuren toepassen D
Verloop toepassen .
Geen toepassen /, Num /
Knop-gereedschap B
Richtingspunt omzetten-gereedschap Shift+C
Ankerpunt verwijderen-gereedschap -
Direct selecteren-gereedschap A
Ovaalkader-gereedschap
Ovaal-gereedschap L
Gummetje
Pipet-gereedschap I
Vrije transformatie E
Verloop-gereedschap G
Hand-gereedschap H
Lijn-gereedschap \
Meetlat-gereedschap K
Pen-gereedschap P
Potlood N
Veelhoekkader-gereedschap
Veelhoek-gereedschap
Rechthoekkader-gereedschap F
Rechthoek-gereedschap M
Rotatie-gereedschap R
Schaal-gereedschap S
Schaar-gereedschap C
Selecteren-gereedschap V
Schuintrekken-gereedschap O
Vloeiend
Vulling en lijn in-/uitschakelen X
Vulling- en lijnkleuren wisselen Shift+X
Tekst- en objectbesturing in-/uitschakelen J
Switch standaard-/voorvertoningsweergave W
Padtekst-gereedschap Shift+T
Tekst-gereedschap T
Zoom-gereedschap Z

Tools

Add Anchor Point Tool =
Apply colour ,
Apply default fill and stroke colours D
Apply gradient .
Apply None /, Num /
Button Tool B
Convert Direction Point Tool Shift+C
Delete Anchor Point Tool -
Direct Selection Tool A
Ellipse Frame Tool
Ellipse Tool L
Erase Tool
Eyedropper Tool I
Free Transform Tool E
Gradient Tool G
Hand Tool H
Line Tool \
Measure Tool K
Pen Tool P
Pencil Tool N
Polygon Frame Tool
Polygon Tool
Rectangle Frame Tool F
Rectangle Tool M
Rotate Tool R
Scale Tool S
Scissors Tool C
Selection Tool V
Shear Tool O
Smooth Tool
Swap fill and stroke activation X
Swap fill and stroke colours Shift+X
Toggle Text and Object Control J
Toggle view setting between default and preview W
Type on a Path Tool Shift+T
Type Tool T
Zoom Tool Z

| InDesign vertaling commando’s |
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Menu’s

Application

About InDesign...
Configure Plug-ins...
Preferences >

General... Cmd+K
Text...
Composition...
Units & Increments...
Grids...
Guides & Pasteboard...
Dictionary...
Spelling...
Story Editor Display...
Display Performance...
File Handling...
Updates...

File

New >
Book...
Document... Cmd+N
Library...

Open... Cmd+O
Close Cmd+W
Save Cmd+S
Save As... Shift+Cmd+S
Save a Copy... Opt+Cmd+S
Save a Version...
Revert
Place... Cmd+D
Import XML...
PDF Export Presets >

Define...
Export... Cmd+E
Document Setup... Opt+Cmd+P
Document Presets >

Define...
File Info...
Preflight... Opt+Shift+Cmd+F
Package for GoLive...
Print Presets >

Define...
Print... Cmd+P

Menu’s

Menu Toepassing

Over InDesign...
Plug-ins configureren...
Voorkeuren >

Algemeen... Cmd+K
Tekst...
Compositie...
Eenheden en toenamen...
Rasters...
Hulplijnen & plakbord...
Woordenboek...
Spelling...
Weergave artikeleditor...
Weergaveprestaties...
Bestandsafhandeling...
Updates...

Menu Bestand

Nieuw >
Boek...
Document... Cmd+N
Bibliotheek...

Openen... Cmd+O
Sluiten Cmd+W
Opslaan Cmd+S
Opslaan als... Shift+Cmd+S
Een kopie opslaan... Opt+Cmd+S
Een versie opslaan...
Terug
Plaatsen... Cmd+D
XML importeren...
Voorinstellingen PDF-export >

Opgeven...
Exporteren... Cmd+E
Documentinstelling... Opt+Cmd+P
Voorinstellingen document >

Definiëren...
Bestandsgegevens...
Preflight... Opt+Shift+Cmd+F
Pakket voor GoLive...
Voorinstellingen afdrukken>

Definiëren...
Afdrukken... Cmd+P
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Bewerken

Ongedaan maken Cmd+Z
Opnieuw Shift+Cmd+Z
Knippen Cmd+X
Kopiëren Cmd+C
Plakken Cmd+V
Plakken in Opt+Cmd+V
Op plaats plakken Opt+Shift+Cmd+V
Wissen Verwijderen, Cmd+Verwijderen, Del, Cmd+Del
Dupliceren Opt+Shift+Cmd+D
Stap en herhalen... Shift+Cmd+V
Alles selecteren Cmd+A
Alles deselecteren Shift+Cmd+A
Bewerken in artikeleditor Cmd+Y
Zoeken/Wijzigen... Cmd+F
Volgende zoeken Opt+Cmd+F
Spellingcontrole... Cmd+I
Woordenboek...
Transparantie-overvloeiruimte >

Document CMYK
Document RGB

Voorinstellingen transparantie-afvlakker...
Kleurinstellingen...
Profielen toewijzen...
Converteren naar profiel...
Sneltoetsen...

Layout

Marges en kolommen...
Liniaalhulplijnen...
Hulplijnen maken...
Aanpassing layout...
Eerste pagina Shift+Cmd+PgUp
Vorige pagina Shift+PgUp
Volgende pagina Shift+PgDn
Laatste pagina Shift+Cmd+PgDn
Volgende spread Opt+PgDn
Vorige spread Opt+PgUp
Terug Cmd+PgUp
Naar voren Cmd+PgDn
Nummerings- en sectie-opties...
Inhoudsopgave...
Inhoudsopgave bijwerken
Stijlen van inhoudsopgave...
Inhoudsopgave met huidige stijl bijwerken

Edit

Undo Cmd+Z
Redo Shift+Cmd+Z
Cut Cmd+X
Copy Cmd+C
Paste Cmd+V
Paste Into Opt+Cmd+V
Paste in Place Opt+Shift+Cmd+V
Clear Delete, Cmd+Delete, Del, Cmd+Del
Duplicate Opt+Shift+Cmd+D
Step and Repeat... Shift+Cmd+V
Select All Cmd+A
Deselect All Shift+Cmd+A
Edit in Story Editor Cmd+Y
Find/Change... Cmd+F
Find Next Opt+Cmd+F
Check Spelling... Cmd+I
Dictionary...
Transparency Blend Space >

Document CMYK
Document RGB

Transparency Flattener Presets...
Colour Settings...
Assign Profiles...
Convert to Profile...
Keyboard Shortcuts...

Layout

Margins and Columns...
Ruler Guides...
Create Guides...
Layout Adjustment...
First Page Shift+Cmd+Page Up
Previous Page Shift+Page Up
Next Page Shift+Page Down
Last Page Shift+Cmd+Page Down
Next Spread Opt+Page Down
Previous Spread Opt+Page Up
Go Back Cmd+Page Up
Go Forward Cmd+Page Down
Numbering & Section Options...
Table of Contents...
Update Table of Contents
Table of Contents Styles...
Update table of contents using current style
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Tekst

Grootte >
Teken Cmd+T
Alinea Opt+Cmd+T
Tabs Shift+Cmd+T
Glyphs
Artikel
Tekenstijlen Shift+F11
Alineastijlen F11
Contouren maken Shift+Cmd+O
Lettertype zoeken...
Hoofd-/kleine letter >

kleine letter
Als in een zin
Alles Beginhoofdletter
HOOFDLETTER

Tekst op pad >
Opties...
Tekst van pad verwijderen

Speciaal teken invoegen >
Autom. pag.nummer Opt+Shift+Cmd+N
Opsommingsteken Opt+8
Copyright-symbool Opt+g
Zacht afbreekstreepje Shift+Cmd+-
Dubbele aanhalingstekens openen Opt+[
Dubbele aanhalingstekens sluiten Opt+Shift+[
Weglatingsteken
Em-streepje Opt+Shift+- 
En-streepje Opt+-
Einde geneste stijl hier
Inspringen tot hier Cmd+\
Volgende paginanummer Opt+Shift+Cmd+]
Vast afbreekstreepje Opt+Cmd+-
Alineasymbool
Vorige paginanummer Opt+Shift+Cmd+[
Interpunctiespatie
Symbool geregistreerd handelsmerk
Rechts ingesprongen tab Shift+Tab
Sectiemarkering
Sectiesymbool
Enkel aanhalingsteken openen Opt+]
Enkel aanhalingsteken sluiten Opt+Shift+]
Tab
Symbool handelsmerk

Spatie(s) invoegen >
Em-spatie Shift+Cmd+M

Type

Size >
Character Cmd+T
Paragraph Opt+Cmd+T
Tabs Shift+Cmd+T
Glyphs
Story
Character Styles Shift+F11
Paragraph Styles F11
Create Outlines Shift+Cmd+O
Find Font...
Change Case >

lowercase
Sentence case
Title Case
UPPERCASE

Type on Path >
Options...
Delete Type from Path

Insert Special Character >
Auto Page Number Opt+Shift+Cmd+N
Bullet Character Opt+8
Copyright Symbol Opt+g
Discretionary Hyphen Shift+Cmd+-
Double Left Quotation Mark Opt+[
Double Right Quotation Mark Opt+Shift+[
Ellipsis
Em Dash Opt+Shift+-
En Dash Opt+-
End Nested Style Here
Indent to Here Cmd+\
Next Page Number Opt+Shift+Cmd+]
Nonbreaking Hyphen Opt+Cmd+-
Paragraph Symbol
Previous Page Number Opt+Shift+Cmd+[
Punctuation Space
Registered Trademark Symbol
Right Indent Tab Shift+Tab
Section Marker
Section Symbol
Single Left Quotation Mark Opt+]
Single Right Quotation Mark Opt+Shift+]
Tab
Trademark Symbol

Insert White Space >
Em Space Shift+Cmd+M
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En-spatie Shift+Cmd+N
Cijferspatie
Uitlijnspatie
Haarfijne spatie Opt+Shift+Cmd+I
Vaste spatie Opt+Cmd+X
Dunne spatie Opt+Shift+Cmd+M

Afbrekingsteken invoegen >
Kolom-einde Enter
Even-pagina-einde
Geforceerd regeleinde Shift+Return
Kader-einde Shift+Enter
Oneven-pagina-einde
Pagina-einde Cmd+Enter
Alineareturn

Vullen met plaatsaanduidingstekst
Verborgen tekens verbergen Opt+Cmd+I

Object

Transformeren >
Hulplijnen verplaatsen...
Verplaatsen... Shift+Cmd+M
Roteren...
Schalen...
Schuintrekken...

Schikken >
Naar voren Cmd+]
Naar voorgrond Shift+Cmd+]
Naar achteren Cmd+[
Naar achtergrond Shift+Cmd+[

Selecteren >
Eerste object boven Opt+Shift+Cmd+]
Volgende object boven Opt+Cmd+]
Volgende object onder Opt+Cmd+[
Laatste object onder Opt+Shift+Cmd+[
Container
Inhoud
Vorig object in groep
Volgend object in groep

Groeperen Cmd+G
Degroeperen Shift+Cmd+G
Positie vergrendelen Cmd+L
Positie ontgrendelen Opt+Cmd+L
Opties tekstkader... Cmd+B
Aanpassen >

Inhoud aan kader aanpassen Opt+Cmd+E
Kader aan inhoud aanpassen Opt+Cmd+C

En Space Shift+Cmd+N
Figure Space
Flush Space
Hair Space Opt+Shift+Cmd+I
Nonbreaking Space Opt+Cmd+X
Thin Space Opt+Shift+Cmd+M

Insert Break Character >
Column Break Enter
Even Page Break
Forced Line Break Shift+Return
Frame Break Shift+Enter
Odd Page Break
Page Break Cmd+Enter
Paragraph Return

Fill with Placeholder Text
Show Hidden Characters Opt+Cmd+I

Object

Transform >
Move Guides...
Move... Shift+Cmd+M
Rotate...
Scale...
Shear...

Arrange >
Bring Forward Cmd+]
Bring to Front Shift+Cmd+]
Send Backward Cmd+[
Send to Back Shift+Cmd+[

Select >
First Object Above Opt+Shift+Cmd+]
Next Object Above Opt+Cmd+]
Next Object Below Opt+Cmd+[
Last Object Below Opt+Shift+Cmd+[
Container
Content
Previous Object in Group
Next Object in Group

Group Cmd+G
Ungroup Shift+Cmd+G
Lock Position Cmd+L
Unlock Position Opt+Cmd+L
Text Frame Options... Cmd+B
Fitting >

Fit Content to Frame Opt+Cmd+E
Fit Frame to Content Opt+Cmd+C
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Inhoud centreren Shift+Cmd+E
Inhoud proportioneel aanpassen Opt+Shift+Cmd+E

Inhoud >
Afbeelding
Tekst
Niet toegewezen

Slagschaduw... Opt+Cmd+M
Doezelaar...
Hoekeffecten...
Uitknippad... Opt+Shift+Cmd+K
Kleurinstellingen afbeelding...
Interactief >

Filmopties...
Geluidsopties...
Knopopties...
Converteren naar knop
Tabvolgorde instellen...

Samengestelde paden >
Maken Cmd+8
Vrijgeven

Pathfinder >
Toevoegen
Aftrekken
Doorsnede
Overlappen uitsluiten
Min achter

Pad omkeren
Weergeven >

Weergave-instelling gebruiken
Geoptimaliseerde weergave
Normale weergave
Weergave van hoge kwaliteit

Tabel

Celopties >
Diagonale lijnen...
Lijnen en vullingen...
Rijen en kolommen...
Tekst... Opt+Cmd+B

Tabel naar tekst converteren...
Tekst naar tabel converteren...
Rijen converteren

Conterveren naar voettekstrijen
Converteren naar bodyrijen
Converteren naar koptekstrijen

Centre Content Shift+Cmd+E
Fit Content Proportionally Opt+Shift+Cmd+E

Content >
Graphic
Text
Unassigned

Drop Shadow... Opt+Cmd+M
Feather...
Corner Effects...
Clipping Path... Opt+Shift+Cmd+K
Image Colour Settings...
Interactive >

Movie Options...
Sound Options...
Button Options...
Convert to Button
Set Tab Order...

Compound Paths>
Make Cmd+8
Release

Pathfinder >
Add
Subtract
Intersect
Exclude Overlap
Minus Back

Reverse Path
Display >

Use View Setting
Optimized Display
Typical Display
High Quality Display

Tables

Cell Options >
Diagonal Lines...
Rows and Columns...
Strokes and Fills...
Text... Opt+Cmd+B

Convert Table to Text...
Convert Text to Table...
Convert Rows

Convert to Body Rows
Convert to Footer Rows
Convert to Header Rows
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Verwijderen >
Kolom Shift+Verwijderen
Rij Cmd+Verwijderen
Tabel

Rijen evenredig verdelen
Kolommen evenredig verdelen
Voettekst bewerken
Koptekst bewerken
Naar rij...
Tabel invoegen... Opt+Shift+Cmd+T
Invoegen >

Kolom... Opt+Cmd+9
Rij... Cmd+9

Cellen samenvoegen
Selecteren >

Bodyrijen
Cel Cmd+/
Kolom Opt+Cmd+3
Voettekstrijen
Koptekstrijen
Rij Cmd+3
Tabel Opt+Cmd+A

Cel horizontaal splitsen
Cel verticaal splitsen
Tabelopties >

Wisselende kolomlijnen...
Wisselende vullingen...
Wisselende rijlijnen...
Kopteksten en voetteksten...
Tabelinstelling... Opt+Shift+Cmd+B

Naar body
Naar voettekst
Naar koptekst
Samenvoegen cellen ongedaan maken

Weergave

Ware grootte Cmd+1
Weergave-instellingen op objectniveau toestaan
Geheel plakbord Opt+Shift+Cmd+0
Pagina in venster passen Cmd+0
Spread in venster passen Opt+Cmd+0
Kaderranden verbergen Cmd+H
Hulplijnen verbergen Cmd+;
Hyperlinks verbergen
Stramienitems verbergen
Linialen verbergen / tonen Cmd+R

Delete >
Column Shift+Delete
Row Cmd+Delete
Table

Distribute Columns Evenly
Distribute Rows Evenly
Edit Footer
Edit Header
Go to Row...
Insert Table... Opt+Shift+Cmd+T
Insert >

Column... Opt+Cmd+9
Row... Cmd+9

Merge Cells
Select >

Body Rows
Cell Cmd+/
Column Opt+Cmd+3
Footer Rows
Header Rows
Row Cmd+3
Table Opt+Cmd+A

Split Cell Horizontally
Split Cell Vertically
Table Options >

Alternating Column Strokes...
Alternating Fills...
Alternating Row Strokes...
Headers and Footers...
Table Setup... Opt+Shift+Cmd+B

To Body
To Footer
To Header
Unmerge Cells

View

Actual Size Cmd+1
Allow Object-Level Display Settings
Entire Pasteboard Opt+Shift+Cmd+0
Fit Page in Window Cmd+0
Fit Spread in Window Opt+Cmd+0
Hide Frame Edges Cmd+H
Hide Guides Cmd+;
Hide Hyperlinks
Hide Master Items
Hide / Show Rulers Cmd+R
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Stijlnaamkolom verbergen
Labelmarkeringen verbergen
Weergave van hoge kwaliteit Opt+Cmd+H
Inktbeheer...
Hulplijnen vergrendelen Opt+Cmd+;
Geoptimaliseerde weergave Opt+Cmd+O
Voorvertoning overdruk Opt+Shift+Cmd+Y
Proefkleuren
Instellen proef >

Aangepast...
Document CMYK
Werkruimte CMYK

Basislijnraster weergeven Opt+Cmd+ʼ
Documentraster weergeven Cmd+ʼ
Structuur weergeven Opt+Cmd+1
Gelabelde kaders verbergen
Tekstverbindingen weergeven Opt+Cmd+Y
Documentraster magnetisch Shift+Cmd+ʼ
Hulplijnen magnetisch Shift+Cmd+;
Normale weergave Opt+Cmd+Z
Inzoomen Cmd+=, Cmd+Num +
Uitzoomen Cmd+-, Cmd+Num -

Venster

Uitlijnen Shift+F7
Kenmerken
Bladwijzers
Alles naar voren
Trapsgewijs
Lokale weergave-instellingen wissen
Kleur F6
Besturing Opt+Cmd+6
Werkruimte verwijderen...
Afvlakker
Verloop
Hyperlinks
Index Shift+F8
Info F8
Lagen F7
Koppelingen Shift+Cmd+D
Eerste werkruimte laden
Tweede werkruimte laden
Derde werkruimte laden
Vierde werkruimte laden
Vijfde werkruimte laden
Minimaliseren Cmd+M

Hide Style Name Column
Hide Tag Markers
High Quality Display Opt+Cmd+H
Ink Manager...
Lock Guides Opt+Cmd+;
Optimised Display Opt+Cmd+O
Overprint Preview Opt+Shift+Cmd+Y
Proof Colours
Proof Setup >

Custom...
Document CMYK
Working CMYK

Show Baseline Grid Opt+Cmd+ʼ
Show Document Grid Cmd+ʼ
Show Structure Opt+Cmd+1
Show Tagged Frames
Show Text Threads Opt+Cmd+Y
Snap to Document Grid Shift+Cmd+ʼ
Snap to Guides Shift+Cmd+;
Typical Display Opt+Cmd+Z
Zoom In Cmd+=, Cmd+Num +
Zoom Out Cmd+-, Cmd+Num -

Window

Align Shift+F7
Attributes
Bookmarks
Bring All To Front
Cascade
Clear Local Display Settings
Colour F6
Control Opt+Cmd+6
Delete Workspace...
Flattener
Gradient
Hyperlinks
Index Shift+F8
Info F8
Layers F7
Links Shift+Cmd+D
Load 1st Workspace
Load 2nd Workspace
Load 3rd Workspace
Load 4th Workspace
Load 5th Workspace
Minimize Cmd+M
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Navigator
Nieuw venster
Pagina s̓ F12
Pathfinder
Werkruimte opslaan...
Scriptlabel
Scripts
Scheidingen Shift+F6
Statussen
Lijn F10
Stalen... F5
Tabel Shift+F9
Labels
Tekstomloop Opt+Cmd+W
Naast elkaar
Gereedschappen
Transformeren F9
Transparantie Shift+F10
Voorinstellingen overvul

Help

InDesign Help... Help
InDesign Online...
Online ondersteuning...
Registratie...
Updates...

Paletmenu’s

Boek >

Document toevoegen...
Documenten automatisch converteren
Nummeringsopties boekpagina s̓...
Boek sluiten
Documentinformatie...
Nummeringsopties documentpagina s̓...
Document verwijderen
Herpagineren
Document vervangen...
Boek opslaan
Boek opslaan als...
Opties synchroniseren...

Navigator
New Window
Pages F12
Pathfinder
Save Workspace...
Script Label
Scripts
Separations Shift+F6
States
Stroke F10
Swatches F5
Table Shift+F9
Tags
Text Wrap Opt+Cmd+W
Tile
Tools
Transform F9
Transparency Shift+F10
Trap Presets

Help

InDesign Help... Help
InDesign Online...
Online Support...
Registration...
Updates...

Palette Menus

Book >

Add Document...
Automatic Document Conversion
Book Page Numbering Options...
Close Book
Document Information...
Document Page Numbering Options...
Remove Document
Repaginate
Replace Document...
Save Book
Save Book As...
Synchronise Options...
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Bladwijzers >

Bladwijzer verwijderen...
Ga naar geselecteerde bladwijzer
Nieuwe bladwijzer
Bladwijzer hernoemen
Bladwijzers sorteren

Tekenstijlen >

Instelling verwijderen
Stijl dupliceren...
Tekenstijlen laden...
Nieuwe tekenstijl...
Stijl opnieuw definiëren Opt+Shift+Cmd+C
Stijlopties...

Teken >

Kapitalen Shift+Cmd+K
Ligaturen
Niet afbreken
OpenType >

[Alles in kleinkapitaal]
[Contextuele alternatieven]
[Standaard cijferstijl]
[Noemer]
[Handmatige ligaturen]
[Breuken]
[Teller]
[Rangtelwoord]
[Proportionele uitlijning]
[Proportioneel mediaeval]
[Subscript/Inferior]
[Superscript/Superior]
[Golf]
[Tabellarische uitlijning]
[Tabellarisch mediaeval]
[Alternatieven titelformaat]

Opties weergeven
Kleinkapitalen Shift+Cmd+H
Doorhalen Shift+Cmd+/
Opties voor doorhalen...
Subscript Opt+Shift+Cmd+=
Superscript Shift+Cmd+=
Onderstrepen Shift+Cmd+U
Opties voor onderstrepen....

Bookmarks >

Delete Bookmark...
Go to Selected Bookmark
New Bookmark
Rename Bookmark
Sort Bookmarks

Character Styles >

Delete Style
Duplicate Style...
Load Character Styles...
New Character Style...
Redefine Style Opt+Shift+Cmd+C
Style Options...

Character >

All Caps Shift+Cmd+K
Ligatures
No Break
OpenType >

[All Small Caps]
[Contextual Alternates]
[Default Figure Style]
[Denominator]
[Discretionary Ligatures]
[Fractions]
[Numerator]
[Ordinal]
[Proportional Lining]
[Proportional Oldstyle]
[Subscript/Inferior]
[Superscript/Superior]
[Swash]
[Tabular Lining]
[Tabular Oldstyle]
[Titling Alternates]

Show Options
Small Caps Shift+Cmd+H
Strikethrough Shift+Cmd+/
Strikethrough Options...
Subscript Opt+Shift+Cmd+=
Superscript Shift+Cmd+=
Underline Shift+Cmd+U
Underline Options....
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Kleur >

Aan stalen toevoegen
Opties verbergen

Voorvertoning afvlakker >

Voorinstellingen transparantie-afvlakker...

Glyph >

Glyph uit set verwijderen
Glyph-set bewerken...
Nieuwe glyph-set...

Verloop >

Opties weergeven

Hyperlinks >

Hyperlink verwijderen
Naar doel
Naar bron
Opties hyperlinkdoel...
Hyperlinkopties...
Nieuw hyperlinkdoel...
Nieuwe hyperlink van URL
Nieuwe hyperlink...
Hyperlink opnieuw instellen
Hyperlink bijwerken

Index >

In hoofdletters...
Verwijderen
Dupliceren...
Zoeken
Index genereren...
Naar geselecteerde markering
Onderwerpen importeren...
Nieuwe kruisverwijzing... Cmd+U
Opties...
Niet-gebruikte onderwerpen verwijderen
Niet-gebruikte onderwerpen weergeven
Voorvertoning bijwerken

Colour >

Add to Swatches
Hide Options

Flattener Preview >

Transparency Flattener Presets...

Glyph >

Delete Glyph from Set
Edit Glyph Set...
New Glyph Set...

Gradient >

Show Options

Hyperlinks >

Delete Hyperlink
Go To Destination
Go To Source
Hyperlink Destination Options...
Hyperlink Options...
New Hyperlink Destination...
New Hyperlink From URL
New Hyperlink...
Reset Hyperlink
Update Hyperlink

Index >

Capitalize...
Delete
Duplicate...
Find
Generate Index...
Go to Selected Marker
Import Topics...
New Page Reference... Cmd+U
Options...
Remove Unused Topics
Show Unused Topics
Update Preview
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Laag >

Laagopties...
Lagen samenvoegen
Nieuwe laag
Lagen behouden bij plakken
Alle lagen weergeven
Alle lagen ontgrendelen

Bibliotheek >

Alle items op pagina toevoegen
Item toevoegen
op naam
op nieuwste
op oudste
op type
Bibliotheek sluiten
Item(s) verwijderen
Item-informatie...
Lijstweergave
Item(s) plaatsen
Alles weergeven
Subset weergeven...
Miniatuurweergave

Koppelingen >

Origineel bewerken
Ontkoppelen
Ga naar koppeling
Koppelingsinformatie...
Bestandsinfo koppeling...
Opnieuw koppelen...
Versie koppeling opslaan...
Koppeling bijwerken

Pagina’s >

Stramien op pagina s̓ toepassen...
Alle objecten scheiden van stramien
Spread dupliceren
Pagina s̓ invoegen...
Stramienopties...
Nieuw stramien...
Nummerings- en sectie-opties...
Alle stramienpag.-items overschrijven Opt+Shift+Cmd+L

Layer >

Layer Options...
Merge Layers
New Layer
Paste Remembers Layers
Show All Layers
Unlock All Layers

Library >

Add All Items on Page
Add Item
by Name
by Newest
by Oldest
by Type
Close Library
Delete Item(s)
Item Information...
List View
Place Item(s)
Show All
Show Subset...
Thumbnail View

Links >

Edit Original
Embed File
Go To Link
Link File Info...
Link Information...
Relink...
Save Link Version...
Update Link

Pages >

Apply Master to Pages...
Detach All Objects From Master
Duplicate Spread
Insert Pages...
Master Options...
New Master...
Numbering & Section Options...
Override All Master Page Items Opt+Shift+Cmd+L
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Alle lokale overschrijvingen verwijderen
Opslaan als stramien
Afvlakking spread >

Aangepast...
Standaard
Geen (transparantie negeren)

Alineastijlen >

Instelling (stijl!) verwijderen
Stijl dupliceren...
Alineastijlen laden...
Nieuwe alineastijl...
Stijl opnieuw definiëren Opt+Shift+Cmd+R
Stijlopties...

Alinea >

Adobe Composer alinea
Adobe Composer enkele regel
Ongelijke regels met elkaar in evenwicht brengen
Initialen en geneste stijlen... Opt+Cmd+R
Opties weergeven
Woordafbreking...
Uitvulling... Opt+Shift+Cmd+J
Opties bijeenhouden... Opt+Cmd+K
Alleen eerste regel op raster uitlijnen
Alinealijnen... Opt+Cmd+J

Voorvertoning scheidingen >

Verzadiging zwart ongedaan maken
Individuele platen in zwart weergeven

Lijn >

Opties verbergen
Lijnstijlen...

Stalen >

Naamloze kleuren toevoegen
Staal verwijderen...
Staal dupliceren
Opties verbergen
Inktbeheer...
Grote staal

Remove All Local Overrides
Save as Master
Spread Flattening >

Custom...
Default
None (Ignore Transparency)

Paragraph Styles >

Delete Style
Duplicate Style...
Load Paragraph Styles...
New Paragraph Style...
Redefine Style Opt+Shift+Cmd+R
Style Options...

Paragraph >

Adobe Paragraph Composer
Adobe Single-line Composer
Balance Ragged Lines
Drop Caps and Nested Styles... Opt+Cmd+R
Hide Options
Hyphenation...
Justification... Opt+Shift+Cmd+J
Keep Options... Opt+Cmd+K
Only Align First Line To Grid
Paragraph Rules... Opt+Cmd+J

Separations Preview >

Desaturate Black
Show Single Plates in Black

Stroke >

Show Options
Stroke Styles...

Swatches >

Add Unnamed Colours
Delete Swatch...
Duplicate Swatch
Hide Options
Ink Manager...
Large Swatch
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Load Swatches...
Merge Swatches
Name
New Colour Swatch...
New Gradient Swatch...
New Mixed Ink Group...
New Mixed Ink Swatch...
New Tint Swatch...
Select All Unused
Small Name
Small Swatch
Swatch Options...

Tab >

Clear All
Repeat Tab

Tags >

Delete Tag...
Load Tags...
New Tag...
Save Tags...
Select All Unused Tags
Small Palette Rows
Tag Options...
Untag Frame

Transform >

Flip Both
Flip Horizontal
Flip Vertical
Reset Scaling to 100%
Rotate 180°
Rotate 90° Anticlockwise
Rotate 90° Clockwise
Scale Text Attributes
Transform Content
Transform Group Content

Transparency >

Show Options

Stalen laden...
Stalen samenvoegen
Naam
Nieuwe kleurenstaal...
Nieuwe verloopstaal
Nieuwe groep gemengde inkt...
Nieuwe staal gemengde inkt...
Nieuwe tintstaal...
Alle ongebruikte selecteren
Kleine naam
Kleine staal
Staalopties...

Tabs >

Alles wissen
Tab herhalen

Labels >

Label verwijderen...
Labels laden...
Nieuw label...
Labels opslaan...
Alle ongebruikte labels selecteren
Kleine paletlagen
Labelopties...
Labels tekst verwijderen

Transformeren >

Beide spiegelen
Horizontaal spiegelen
Verticaal spiegelen
Schaal opnieuw instellen op 100%
180° roteren
90° linksom roteren
90° rechtsom roteren
Tekstkenmerken schalen
Inhoud transformeren
Inhoud groep transformeren

Transparantie >

Opties verbergen
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Trap Presets >

Assign Trap Preset...
Delete Presets
Duplicate Preset...
Load Trap Presets...
New Preset...
Preset Options...
Select All Unused

Other

Object Editing

Convert Clipping Path to Frame
Decrease size / scale by 1% Cmd+,
Decrease size / scale by 5% Opt+Cmd+,
Horizontal Align Centre
Horizontal Align Left
Horizontal Align Right
Horizontal Distribute Centre
Horizontal Distribute Left
Horizontal Distribute Right
Horizontal Distribute Space
Increase size / scale by 1% Cmd+,
Increase size / scale by 5% Opt+Cmd+.
Nudge down Down Arrow
Nudge down 1/10 Shift+Cmd+Down Arrow
Nudge down 1/10 duplic. Opt+Shift+Cmd+Down Arrow
Nudge down duplicate Opt+Down Arrow
Nudge down x10 Shift+Down Arrow
Nudge down x10 duplicate Opt+Shift+Down Arrow
Nudge left Left Arrow
Nudge left 1/10 Shift+Cmd+Left Arrow
Nudge left 1/10 duplicate Opt+Shift+Cmd+Left Arrow
Nudge left duplicate Opt+Left Arrow
Nudge left x10 Shift+Left Arrow
Nudge left x10 duplicate Opt+Shift+Left Arrow
Nudge right Right Arrow
Nudge right 1/10 Shift+Cmd+Right Arrow
Nudge right 1/10 dupl. Opt+Shift+Cmd+Right Arrow
Nudge right duplicate Opt+Right Arrow
Nudge right x10 Shift+Right Arrow
Nudge right x10 duplicate Opt+Shift+Right Arrow
Nudge up Up Arrow
Nudge up 1/10 Shift+Cmd+Up Arrow
Nudge up 1/10 duplicate Opt+Shift+Cmd+Up Arrow

Voorinstellingen overvul >

Voorinstelling overvul toewijzen...
Voorinstellingen verwijderen
Voorinstelling dupliceren...
Voorinstellingen overvul laden...
Nieuwe voorinstelling...
Opties voorinstelling...
Alle ongebruikte selecteren

Overig

Bewerken van object

Uitknippad naar kader converteren
Vergroten / schalen met 1%
Vergroten / schalen met 5% Opt+Cmd+.
Horizontaal centreren
Horizontaal links uitlijnen
Horizontaal rechts uitlijnen
Horizontaal midden verdelen
Horizontaal links verdelen
Horizontaal rechts verdelen
Horizontale ruimte verdelen
Verkleinen / schalen met 1% Cmd+,
Verkleinen / schalen met 5% Opt+Cmd+,
Stapsgewijs omlaag Pijl-omlaag
Stapsgewijs 1/10 omlaag Shift+Cmd+Pijl-omlaag
Stapsgew. 1/10 omlaag dupl. Opt+Shift+Cmd+Pijl-oml.
Stapsgewijs omlaag dupliceren Opt+Pijl-omlaag
Stapsgewijs x10 omlaag Shift+Pijl-omlaag
Stapsgewijs x10 oml. dupl. Opt+Shift+Pijl-omlaag
Stapsgewijs naar links Pijl-links
Stapsgewijs 1/10 naar links Shift+Cmd+Pijl-links
Stapsgew. 1/10 n. links dupl. Opt+Shift+Cmd+Pijl-links
Stapsgewijs naar links dupliceren Opt+Pijl-links
Stapsgewijs x10 naar links Shift+Pijl-links
Stapsgewijs x10 n. links dupl. Opt+Shift+Pijl-links
Stapsgewijs naar rechts Pijl-rechts
Stapsgewijs 1/10 naar rechts Shift+Cmd+Pijl-rechts
Stapsgew. 1/10 n. rechts dupl. Opt+Shift+Cmd+Pijl-rechts
Stapsgewijs naar rechts dupliceren Opt+Pijl-rechts
Stapsgewijs x10 naar rechts Shift+Pijl-rechts
Stapsgewijs x10 n. rechts dupl. Opt+Shift+Pijl-rechts
Stapsgewijs omhoog Pijl-omhoog
Stapsgewijs 1/10 omhoog Shift+Cmd+Pijl-omhoog
Stapsgew. 1/10 omhoog dupl. Opt+Shift+Cmd+Pijl-omh.
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Nudge up duplicate Opt+Up Arrow
Nudge up x10 Shift+Up Arrow
Nudge up x10 duplicate Opt+Shift+Up Arrow
Select all guides Opt+Cmd+G
Vertical Align Bottom
Vertical Align Centre
Vertical Align Top
Vertical Distribute Bottom
Vertical Distribute Centre
Vertical Distribute Space
Vertical Distribute Top

Text and Tables

0°
180°
270°
90°
Align centre Shift+Cmd+C
Align force justify Shift+Cmd+F
Align justify Shift+Cmd+J
Align left Shift+Cmd+L
Align right Shift+Cmd+R
Align to baseline grid Opt+Shift+Cmd+G
Apply bold Shift+Cmd+B
Apply italic Shift+Cmd+I
Apply normal Shift+Cmd+Y
Auto leading Opt+Shift+Cmd+A
Auto-hyphenate on/off Opt+Shift+Cmd+H
Clear Delete
Decrease baseline shift Opt+Shift+Down Arrow
Decrease baseline shift x 5  
 Opt+Shift+Cmd+Down Arrow
Decrease kerning/tracking Opt+Left Arrow
Decrease kerning/tracking x 5 Opt+Cmd+Left Arrow
Decrease leading Opt+Up Arrow
Decrease leading x 5 Opt+Cmd+Up Arrow
Decrease point size Shift+Cmd+,
Decrease point size x 5 Opt+Shift+Cmd+,
Decrease word space Opt+Cmd+Delete
Decrease word space x 5 Opt+Shift+Cmd+Delete
Delete Del
Find Next Shift+F2
Increase baseline shift Opt+Shift+Up Arrow
Increase baseline shift x 5 Opt+Shift+Cmd+Up Arrow
Increase kerning/tracking Opt+Right Arrow
Increase kerning/tracking x 5 Opt+Cmd+Right Arrow

Stapsgewijs omhoog dupliceren Opt+Pijl-omhoog
Stapsgewijs x10 omhoog Shift+Pijl-omhoog
Stapsgewijs x10 omh. dupl. Opt+Shift+Pijl-omhoog
Alle hulplijnen selecteren Opt+Cmd+G
Verticaal onder uitlijnen
Verticaal centreren
Verticaal boven uitlijnen
Verticaal onder verdelen
Verticaal midden verdelen
Verticale ruimte verdelen
Verticaal boven verdelen

Tekst en tabellen

0°
180°
270°
90°
Centreren Shift+Cmd+C
Geforceerd uitvullen Shift+Cmd+F
Uitvullen Shift+Cmd+J
Links uitlijnen Shift+Cmd+L
Rechts uitlijnen Shift+Cmd+R
Uitlijnen op basislijnraster Opt+Shift+Cmd+G
Vet maken Shift+Cmd+B
Cursief maken Shift+Cmd+I
Normaal toepassen Shift+Cmd+Y
Automatische regelafstand Opt+Shift+Cmd+A
Automatische woordafbr. aan/uit Opt+Shift+Cmd+H
Wissen Verwijderen
Verschuiv. basislijn verkleinen Opt+Shift+Pijl-omlaag
Verschuiving basislijn 5 keer verkleinen 
 Opt+Shift+Cmd+Pijl-omlaag
Letter-/reeksspatiëring verkleinen Opt+Pijl-links
Letter-/reeksspatiër. 5x verkleinen Opt+Cmd+Pijl-links
Regelafstand verkleinen Opt+Pijl-omhoog
Regelafstand 5 keer verkleinen Opt+Cmd+Pijl-omhoog
Corps verkleinen Shift+Cmd+,
Corps 5 keer meer verkleinen Opt+Shift+Cmd+,
Tussenruimte woorden verkl. Opt+Cmd+Verwijder
Tussenruimte wrd. 5x verkl.  Opt+Shift+Cmd+Verwijder
Verwijderen Del
Volgende zoeken Shift+F2
Verschuiv. basislijn vergroten Opt+Shift+Pijl-omhoog
Verschuiv. basisl. 5x vergr. Opt+Shift+Cmd+Pijl-omh.
Letter-/reeksspatiëring vergroten Opt+Pijl-rechts
Letter-/reeksspatiër. 5x vergroten Opt+Cmd+Pijl-rechts
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Increase leading Opt+Down Arrow
Increase leading x 5 Opt+Cmd+Down Arrow
Increase point size Shift+Cmd+.
Increase point size x 5 Opt+Shift+Cmd+.
Increase word space Opt+Cmd+\
Increase word space x 5 Opt+Shift+Cmd+\
Insert Column Opt+Cmd+9
Insert Row Cmd+9
Keep with Next Row
Load Find and Find Next instance Shift+F1
Load Find with selected text Cmd+F1
Load Replace with selected text Cmd+F2
Move Down Down Arrow
Move down one line Down Arrow
Move Left Left Arrow
Move Right Right Arrow
Move to beginning of story Cmd+Home
Move to end of story Cmd+End
Move to First Cell in Column Opt+Page Up
Move to First Cell in Row Opt+Home
Move to First Row in Frame Page Up
Move to Last Cell in Column Opt+Page Down
Move to Last Cell in Row Opt+End
Move to Last Row in Frame Page Down
Move to Next Cell Tab
Move to Previous Cell Shift+Tab
Move to the end of the line End
Move to the left one character Left Arrow
Move to the left one word Cmd+Left Arrow
Move to the next paragraph Cmd+Down Arrow
Move to the previous paragraph Cmd+Up Arrow
Move to the right one character Right Arrow
Move to the right one word Cmd+Right Arrow
Move to the start of the line Home
Move Up Up Arrow
Move up one line Up Arrow
Normal horizontal text scale Shift+Cmd+X
Normal vertical text scale Opt+Shift+Cmd+X
Recompose all stories Opt+Cmd+/
Recompose all stories immediately
Replace with Change To text Cmd+F3
Replace with Change To text and Find Next Shift+F3
Reset kerning and tracking Opt+Cmd+Q
Select Cells Above Shift+Up Arrow
Select Cells Below Shift+Down Arrow
Select Cells to the Left Shift+Left Arrow
Select Cells to the Right Shift+Right Arrow

Regelafstand vergroten Opt+Pijl-omlaag
Regelafstand 5 keer vergroten Opt+Cmd+Pijl-omlaag
Corps vergroten Shift+Cmd+.
Corps 5 keer meer vergroten Opt+Shift+Cmd+.
Tussenruimte woorden vergroten Opt+Cmd+\
Tussenruimte wrd 5x vergroten Opt+Shift+Cmd+\
Kolom invoegen Opt+Cmd+9
Rij invoegen Cmd+9
Bij volgende rij houden
Zoeken naar geselecteerde tekst starten Cmd+F1
Zoeken starten en volgende zoeken Shift+F1
Vervangen door geselecteerde tekst starten Cmd+F2
Omlaag verplaatsen Pijl-omlaag
Eén regel omlaag Pijl-omlaag
Naar links verplaatsen Pijl-links
Naar rechts verplaatsen Pijl-rechts
Naar begin van artikel Cmd+Home
Naar einde van artikel Cmd+End
Naar eerste cel in kolom verplaatsen Opt+PgUp
Naar eerste cel in rij verplaatsen Opt+Home
Naar eerste rij in kader verplaatsen PgUp
Naar laatste cel in kolom verplaatsen Opt+PgDn
Naar laatste cel in rij verplaatsen Opt+End
Naar laatste rij in kader verplaatsen PgDn
Naar volgende cel Tab
Naar vorige cel Shift+Tab
Naar einde van regel End
Eén teken naar links Pijl-links
Eén woord naar links Cmd+Pijl-links
Naar volgende alinea Cmd+Pijl-omlaag
Naar vorige alinea Cmd+Pijl-omhoog
Eén teken naar rechts Pijl-rechts
Eén woord naar rechts Cmd+Pijl-rechts
Naar begin van regel Home
Omhoog verplaatsen Pijl-omhoog
Eén regel omhoog Pijl-omhoog
Normale horizontale tekstschaal Shift+Cmd+X
Normale verticale tekstschaal Opt+Shift+Cmd+X
Alle artikelen opnieuw samenstellen Opt+Cmd+/
Alle artikelen direct opnieuw samenstellen
Vervangen door “Wijzigen in”-tekst Cmd+F3
Vervang door “Wijz.in”-tekst en volg. zoeken Shift+F3
Letter- en reeksspatiër. opnieuw instellen Opt+Cmd+Q
Cellen boven selecteren Shift+Pijl-omhoog
Cellen onder selecteren Shift+Pijl-omlaag
Cellen links selecteren Shift+Pijl-links
Cellen rechts selecteren Shift+Pijl-rechts
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Regel selecteren Shift+Cmd+\
Eén teken links selecteren Shift+Pijl-links
Eén teken rechts selecteren Shift+Pijl-rechts
Eén regel omhoog selecteren Shift+Pijl-omhoog
Eén regel omlaag selecteren Shift+Pijl-omlaag
Eén alinea terug selecteren Shift+Cmd+Pijl-omhoog
Eén alinea vooruit selecteren Shift+Cmd+Pijl-omlaag
Eén woord links selecteren Shift+Cmd+Pijl-links
Eén woord rechts selecteren Shift+Cmd+Pijl-rechts
Tot begin van artikel selecteren Shift+Cmd+Home
Tot einde van artikel selecteren Shift+Cmd+End
Tot einde van regel selecteren Shift+End
Tot begin van regel selecteren Shift+Home
Rij bij volgende kolom laten beginnen Enter
Rij bij volgend kader laten beginnen Shift+Enter
Composer wisselen
Automatisch vergroten in- of uitschakelen
Cel-/tekstselectie in- of uitschakelen Escape
Voorkeur typografische aanhalingstekens wisselen 
 Opt+Shift+Cmd+ʼ
Ontbrekende lettertypenlijst bijwerken Opt+Shift+Cmd+/

Besturing

Bovenaan koppelen
Onderaan koppelen
Zweven

Weergaven, Navigatie

200% Cmd+2
400% Cmd+4
50% Cmd+5
Toegang paginanummervak Cmd+J
Toegang vak in-/uitzoomen Opt+Cmd+5
Laatst gebruikt veld in palet activeren Opt+Cmd+`
Eerste spread Home, Opt+Shift+PgUp
Selectie in venster passen Opt+Cmd+=
Opnieuw beeldopbouw forceren Shift+F5
Naar eerste kader Opt+Shift+Cmd+PgUp
Naar laatste kader Opt+Shift+Cmd+PgDn
Naar volgend kader Opt+Cmd+PgDn
Naar vorig kader Opt+Cmd+PgUp
Rasters naar achteren
Hulplijnen naar achteren
Horizontale liniaal >

Centimeters

Select line Shift+Cmd+\
Select one character to the left Shift+Left Arrow
Select one character to the right Shift+Right Arrow
Select one line above Shift+Up Arrow
Select one line below Shift+Down Arrow
Select one paragraph before Shift+Cmd+Up Arrow
Select one paragraph forward Shift+Cmd+Down Arrow
Select one word to the left Shift+Cmd+Left Arrow
Select one word to the right Shift+Cmd+Right Arrow
Select to beginning of story Shift+Cmd+Home
Select to end of story Shift+Cmd+End
Select to the end of the line Shift+End
Select to the start of the line Shift+Home
Start Row on Next Column Enter
Start Row on Next Frame Shift+Enter
Switch composer
Toggle Autogrow
Toggle Cell/Text Selection Escape
Toggle Typographer s̓ Quotes preference 
 Opt+Shift+Cmd+ʼ
Update missing font list Opt+Shift+Cmd+/

Control

Dock at Bottom
Dock at Top
Float

Views, Navigation

200% size Cmd+2
400% size Cmd+4
50% size Cmd+5
Access page number box Cmd+J
Access zoom percentage box Opt+Cmd+5
Activate last-used field in palette Opt+Cmd+`
First Spread Home, Opt+Shift+Page Up
Fit Selection in Window Opt+Cmd+=
Force redraw Shift+F5
Go to first frame Opt+Shift+Cmd+Page Up
Go to last frame Opt+Shift+Cmd+Page Down
Go to next frame Opt+Cmd+Page Down
Go to previous frame Opt+Cmd+Page Up
Grids in Back
Guides in Back
Horizontal Ruler >

Centimetres



19

Cicero s̓
Aangepast...
Inches
Decimale inches
Millimeters
Pica s̓
Punten

Laatste spread End, Opt+Shift+PgDn
Volgende venster Cmd+F6
Alle paletten in zijtabs openen/sluiten Opt+Cmd+Tab
Alle paletten in linkerzijtabs openen/sluiten
Alle paletten in rechterzijtabs openen/sluiten
Vorige venster Shift+Cmd+F6
Liniaal op rug
Liniaal per pagina
Liniaal per spread
Eén scherm omlaag schuiven PgDn
Eén scherm omhoog schuiven PgUp
Eerste steunplaat weergeven Opt+Shift+Cmd+5
Tweede steunplaat weergeven Opt+Shift+Cmd+6
Derde steunplaat weergeven Opt+Shift+Cmd+7
Vierde steunplaat weergeven Opt+Shift+Cmd+8
Vijfde steunplaat weergeven Opt+Shift+Cmd+9
Alle platen weergeven Opt+Shift+Cmd+`
Zwarte plaat weergeven Opt+Shift+Cmd+4
Cyaan plaat weergeven Opt+Shift+Cmd+1
Magenta plaat weergeven Opt+Shift+Cmd+2
Gele plaat weergeven Opt+Shift+Cmd+3
Alle paletten weergeven/verbergen Tab
Overschrijv. onderdrukk. (weergave geoptimalis.) Cmd+.
Alle palet. behalve gereedschapsset in-/uitsch. Shift+Tab
Wisselen tuss. huidige en vorige weergav. Opt+Cmd+2
Teken- en alineamodus in besturingspalet  
in- of uitschakelen Opt+Cmd+7
Focus van toetsenbord in besturingspalet  
in- of uitschakelen Cmd+6
Meetsysteem in-/uitschakelen Opt+Shift+Cmd+U
Verticale liniaal >

Centimeters
Cicero s̓
Aangepast...
Inches
Decimale inches
Millimeters
Pica s̓
Punten

Ciceros
Custom...
Inches
Inches Decimal
Millimetres
Picas
Points

Last Spread End, Opt+Shift+Page Down
Next window Cmd+F6
Open/Close all palettes in side tabs Opt+Cmd+Tab
Open/Close palettes in left side tabs
Open/Close palettes in right side tabs
Previous window Shift+Cmd+F6
Ruler On Spine
Ruler Per Page
Ruler Per Spread
Scroll down one screen Page Down
Scroll up one screen Page Up
Show 1st spot plate Opt+Shift+Cmd+5
Show 2nd spot plate Opt+Shift+Cmd+6
Show 3rd spot plate Opt+Shift+Cmd+7
Show 4th spot plate Opt+Shift+Cmd+8
Show 5th spot plate Opt+Shift+Cmd+9
Show all plates Opt+Shift+Cmd+`
Show Black plate Opt+Shift+Cmd+4
Show Cyan plate Opt+Shift+Cmd+1
Show Magenta plate Opt+Shift+Cmd+2
Show Yellow plate Opt+Shift+Cmd+3
Show/Hide all palettes Tab
Suppress overrides (view optimised) Cmd+.
Toggle all palettes except toolbox Shift+Tab
Toggle betw. current and previous views Opt+Cmd+2
Toggle Character and Paragraph Modes  
in Control Panel Opt+Cmd+7
Toggle Keyboard Focus in Control Palette 
 Cmd+6
Toggle Measurement System Opt+Shift+Cmd+U
Vertical Ruler >

Centimetres
Ciceros
Custom...
Inches
Inches Decimal
Millimetres
Picas
Points
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Other...

Add new index entry Opt+Cmd+U
Add new index entry (reversed) Shift+Cmd+F8
Add New Page Shift+Cmd+P
Add new topic
Clear Local Display Settings Shift+Cmd+F2
Close all Opt+Shift+Cmd+W
Close document Shift+Cmd+W
Create outlines without deleting text 
 Opt+Shift+Cmd+O
Lock Zero Point
New default document Opt+Cmd+N
Open index entry dialog Cmd+U
Save all Opt+Shift+Cmd+S
Unlock Zero Point

Overig...

Nieuw indexitem toevoegen Opt+Cmd+U
Nw. indexitem toev. (omgekeerd) Shift+Cmd+F8
Nieuwe pagina toevoegen Shift+Cmd+P
Nieuw onderwerp toevoegen
Lokale weergave-instellingen wissen Shift+Cmd+F2
Alles sluiten Opt+Shift+Cmd+W
Document sluiten Shift+Cmd+W
Contouren maken zonder tekst te verwijderen 
 Opt+Shift+Cmd+O
Nulpunt vastzetten
Nieuw standaarddocument Opt+Cmd+N
Dialoogvenster Indexitem openen Cmd+U
Alles opslaan Opt+Shift+Cmd+S
Nulpunt losmaken


